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Revision History 
Date Comments Engineer Version 
04/04/03 First release PSR 1.0 

13/06/03 Example code removed as part of package PSR 1.1 

19/10/05 Reflect changes made in the software EW 1.2 

11/01/08 Added Getting Started CH 1.3 

18/04/08 New pictures added CH 1.4 
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Contacting Sundance. 
You can contact Sundance for additional information by sending email to 
support@sundance.com.  

 

Notes. 
- SHB stands for Sundance High-speed Bus. 
- CommPort denotes an 8-bit communication port following the TI C4x 

standards. 
- SMT8036E is a PCI system to be plugged in a PC. The only software 

requirement is to have 3L Diamond server installed. 
 

Precautions 
In order to guarantee that Sundance’s boards function correctly and to protect the 
module from damage, the following precautions should be taken: 

- They are static sensitive products and should be handled accordingly. 
Always place the modules in a static protective bag during storage and 
transition. 

- When operated in a closed environment make sure that the heat 
generated by the system is extracted e.g. a fan extracting heat or blowing 
cool air. 

- External Power via the connector is not strictly required, but can be 
recommended as some Motherboards has a Power limitation on it’s PCI 
slots.  If you think you are having this problem, please contact Sundace. 

mailto:support@sundance.com
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Outline description. 
 
The SMT8036E is a C64xx-based module (SMT365E) combined with a dual high-
speed ADC/DAC module (SMT370). 
SMT365E characteristics: 

⇒ TMS320C6416 rev1.1 processor running at 600MHz 

⇒ Six 400Mbytes/s Sundance High-speed Bus ports (SHB). 

⇒ Six 20MB/s communication ports (comm.-ports) 

⇒ 256MB of SDRAM (100MHz) 

⇒ 8MByte Flash ROM for boot code and FPGA programming 

⇒ Global expansion connector on a double width module 
 

SMT370 characteristics: 

⇒ Two 14-bit ADCs (AD6645-105) sampling at up to 105MHz, 

⇒ Dual 16-bit TxDAC (AD9777) sampling at up to 400MHz (interpolation), 

⇒ Two Sundance High-speed Bus (SHB) connectors, 

⇒ Two 20 MegaByte/s communication ports, 

⇒ Low-jitter on-board system clock, 

⇒ Xilinx Virtex-II FPGA, 

⇒ 50-Ohm terminated analogue inputs and outputs, external triggers and     
clocks via MMBX (Huber and Suhner) connectors, 

⇒ User defined pins for external connections, 

⇒ Compatible with a wide range of Sundance SHB modules, 

⇒ TIM standard compatible, 

⇒ Default FPGA firmware implementing all the functions described along this 
documentation. 

 
The SMT8036E is a demonstration system for the evaluation of the SMT365E and 
SMT370 modules. It can be used for prototyping 3G (3rd generation) systems and 
high-speed data acquisition system with or without digital processor. This document 
is an installation guide for the SMT8036E demonstration system. 
Documentation and source files are installed by the way of the SMT6600 package, 
which is the Sundance DAQ package. Source and application files provided are 
to be run via the 3L Diamond Server only.  

http://products.analog.com/products/genericInfo.asp?product=AD6645
http://products.analog.com/products/genericInfo.asp?product=AD9777


Version 1.0 Page 6 of 12 SMT8036E User Manual 

 

The SMT8036E application causes the DSP on the SMT365E to configure the DAC 
of the SMT370 to generate a continuous sine wave via a first SHB connection. DAC 
outputs are looped onto the ADCs inputs. The DSP grabs data from both channels 
and stores them into a file, which can be read by a Matlab application for data 
displaying and FFT processing. Sampling clocks (100MHz for the ADCs and 160MHz 
for the DAC) are generated by on-board clock synthesizers.   
 

Architecture. 
 
The following diagram shows the architecture of the SMT8036E system: 
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Hardware involved. 
 
The SMT8036E is built around two main modules but also involves a carrier board 
and some cables to connect them and allow them to communicate with each other 
and to access the PC. 

⇒ 1x SMT310Q: PCI carrier 

⇒ 1x SMT365E: C64xx-based module; to be plugged on site 1 and 2 of SMT310Q. 

⇒ 1x SMT370: Dual ADC/DAC module; to be plugged on site 3 of SMT310Q. 

⇒ 1x long FMS cable (30cm): Comport FMS cable from TIM1-Comport2 (T1C2) to 
TIM3-Comport3 (T3C3) 

⇒ 2x SHB cable (standard length):  
- SHB cable connecting SHB0 on the SMT365E to SHB0 on the SMT370  
- SHB cable connecting SHB1 on the SMT365E to SHB1 on the SMT370 

⇒ 2x MMBX to MMBX cables to connect J10 to J12 and JJ9 to J13 on the SMT370. 
(For your system, you could have an SMT509-PCB replacing these MMBX cables) 
 

Hardware installation. 
 
Here are the steps to follow to install the SMT8036 system. 

1. Place the SMT365E on TIM sites 1&2 of the carrier board (SMT310Q). 
2. Place the SMT370 on TIM site 3 of the carrier board (SMT310Q). 
3. Make sure that the boards are firmly seated, then provide the 3.3V to the 

boards by screwing down the modules through the mounting holes of the 
SMT365E and SMT370. 

4. Connect the comport FMS cable from TIM1-Comport2 (T1C2) to TIM3-
Comport3 (T3C3) on the back of the SMT310Q. 

5. Connect one of the SHB cables between SHB0 on the SMT365E to SHB0 on 
the SMT370. 

6. Connect the other SHB cable between SHB1 on the SMT365E to SHB1 on the 
SMT370. 

7. Use the included analogue PCB (SMT509-PCB)  to make a loopback 
connection or the analogue cables to acquire and send the signals from the 
outside. 
(If cables were supplied, connected J9 to J13 and J10 to J12 of the SMT370) 

8. Place the carrier board in the host system. 
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The following picture shows how connections are made at the top of the system: 
 

 
 
The following picture shows the CommPort connection at the back of the SMT310Q. 
Note that the FMS are ‘twisted’, i.e. one end should be blue and the other should 
show silver pins. 
 

 
 



Version 1.0 Page 9 of 12 SMT8036E User Manual 

 

Getting Started 
 
This is a general guideline to help you get started with your new SDR Kit as soon as 
possible.  
 
Please follow these steps and take your time to understand how our technology 
works.  
 
Install all Sundance SW tools using the Sundance Wizard or Sundance CD  
 
SW TOOLS PASSWORDS  
You have to use different sets of passwords for the CD installation or the Web 
installation. Please request the passwords from us via email or on your reserved 
Sundance Forum.  
 
Sundance Wizard Internet Edition:  
http://support.sundance.com/updates/Wizard/setup.exe  
 
CCS Installation:  
CCS requires manual configuration.  
You can find a general overview of the procedure here:  
http://support.sundance.com/viewtopic.php?p=13638#13638  
 
Please keep in mind these differences from the procedure above:  
 
1. To properly set up the SMT310Q, you have to copy the I/O port address from the 
value shown by the SMT6300 SmtBoardInfo Utility.  
 
2. Do not use any GEL files.  
 
3. For the DSP processor type, make sure that you select the one called 
SMT365E_11_DSP.  
Hardware Getting Started  
 
The Kit comprises of these modules: SMT310Q + SMT365E + SMT370  
 
Please read the following documentation:  
SMT310Q User Manual: 
http://www.sundance.com/docs/SMT310Q%20User%20Manual.pdf  
 
SMT365E User Manual: 
http://www.sundance.com/docs/smt365e%20user%20manual.pdf  

http://support.sundance.com/updates/Wizard/setup.exe
http://support.sundance.com/viewtopic.php?p=13638#13638
http://www.sundance.com/docs/SMT310Q%20User%20Manual.pdf
http://www.sundance.com/docs/smt365e%20user%20manual.pdf
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SMT370 User Manual: 
http://www.sundance.com/docs/SMT370%20User%20Manual.pdf  
 
Sundance Help (general introduction to our technology): 
http://www.sundance.com/docs/Sundance.chm  
 
SMT6012 (Code Composer Studio drivers): 
http://www.sundance.com/docs/SMT6012.chm  
 
SMT6001 Help (all about Flash programming and bootloaders/bitstreams): 
http://www.sundance.com/docs/SMT6001.chm  
 
SMT6300 (general utilities and testing): documentation installed on your hard disk  
 
Very Important:  
The DSP on the SMT365E will take approximately 46 seconds to configure the FPGA 
following reset, assuming a 600MHz clock.  
The external devices implemented in the FPGA (such as comports) must not be used 
during this configuration.  
 
It is safest to wait for the configuration to complete.  
Please note that comports will appear to be "not ready" until the FPGA has been 
configured.  
 
When any Diamond application will be run (please refer to the following section) the 
Diamond Server will issue a board reset and then send the application to the host 
comport.  
Since the tranfer is not delayed, the SMT365E FPGA won't be ready to receive it, 
and the application will hang.  
 
This can be avoided by using the Advanced Options available when selecting 
Options from the View menu of the Diamond Server, and then selecting the 
Advanced tab.  
There, you will be able to either set a proper delay before running the application, or 
prevent the Diamond Server to issue a reset by ticking the checkbox called: "Do not 
issue a reset before running an application".  
 
 
 

http://www.sundance.com/docs/SMT370%20User%20Manual.pdf
http://www.sundance.com/docs/Sundance.chm
http://www.sundance.com/docs/SMT6012.chm
http://www.sundance.com/docs/SMT6001.chm
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Software Getting Started  
 
Your software includes:  
Diamond DSP single proc and Diamond FPGA single proc  
They form a unified development environment which takes care of the low-level 
details and let you concentrate on the hi-level tasks that make up your project.  
 
We recommend you to browse carefully the following documents to get the most out 
of your Diamond Kit.  
Basic concept:  
http://www.3l.com/Diamond/Sundance/diamond_for_sundance.htm  
 
Diamond User Guide: 
http://www.3l.com/Documents/Diamond%20Sundance%20C6000.pdf  
 
Diamond IDE User Guide:  
http://www.3l.com/Documents/IDE.pdf  
 
Diamond IDE live presentation (in English): 
http://www.3l.com/IDE/IDE%2520Demo.htm  
 
It is important that you both get proficient with the Diamond IDE and are able to build 
by yourself the basic 'Hello World' Diamond example.  
 
SDR8036E demo package  
We provide you with a Diamond IDE project with full source code to let you test your 
system.  
 
This project can be used as a blueprint for further development on your part.  
SDR8036E demo package: 
ftp://ftp2.sundance.com/pub/Support_Files/Gabriele/8036e/package_sdr8036e.zip  
 
Please read the included PDF file which explains how to import the archived sub-
projects into a new workspace.  
 
We recommend you to run this diamond application via the Diamond Server:  

1. Open the Diamond Server.   
2. Select Options from the View menu of the Diamond Server, and then select 

the Advanced tab.  
3. Tick the checkbox called: "Do not issue a reset before running an application". 

Click on OK.   

http://www.3l.com/Diamond/Sundance/diamond_for_sundance.htm
http://www.3l.com/Documents/Diamond%20Sundance%20C6000.pdf
http://www.3l.com/Documents/IDE.pdf
http://www.3l.com/IDE/IDE%2520Demo.htm
ftp://ftp2.sundance.com/pub/Support_Files/Gabriele/8036e/package_sdr8036e.zip
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4. Select Application from the File menu.   
If you have run the application previously, or the application doesn’t seem to run correctly, 
press the reset button in the 3L server window to send a reset signal.  After 46 seconds the 
board should be configured and you can try again. 

5. Locate and select the pre-compiled application you downloaded from here: 
ftp://ftp2.sundance.com/pub/Support_Files/Gabriele/8036e/com.sundance.exa
mple.sdr8036e.app  
 
 

Please note that the SDR8036E demo requires various connections between the 
modules. The system is shipped with the right connections;  
for your reference the required connections are:  
- Comport FMS cable from TIM1-Comport2 (T1C2) to TIM3-Comport3 (T3C3)  
- SHB cable connecting SHB0 on the SMT365E to SHB0 on the SMT370  
- SHB cable connecting SHB1 on the SMT365E to SHB1 on the SMT370  
- Use the included analogue PCB to make a loopback connection or the analogue 
cables to acquire and send the signals from the outside.  
 
The dialogs that appear when the demo is run will let you fine-tune the 
acquisition.  
 

SMT6025  
The SMT6025 is a host-side software interface to Sundance hardware.  
Apart from the Diamond Server, you can use the SMT6025 to develop stand-alone 
programs to send and receive data between your PC and the SMT8036E SDR Kit.  
The SMT6025 provides many examples and source code (both Host-side and DSP-
side).  
SMT6025 User Manual: 
http://www.sundance.com/docs/6025%20User%20Manual.pdf  

 

ftp://ftp2.sundance.com/pub/Support_Files/Gabriele/8036e/com.sundance.example.sdr8036e.app
ftp://ftp2.sundance.com/pub/Support_Files/Gabriele/8036e/com.sundance.example.sdr8036e.app
http://www.sundance.com/docs/6025%20User%20Manual.pdf
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